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I. About this class 
 

A. Just the basics…  
In this class, we will show you how to complete some basic tasks on the computer.  We 
want you to leave this class understanding what you can do on the computer and with 
enough knowledge to get started on your own. We will learn to create files and manage 
them. We will use Microsoft Word and Chrome to learn some of the basic Microsoft 
software commands. Many of these skills are the same ones you would use in the other 
programs as well.  
 

A. When you are working with PCs, the standard programs that you use come from Microsoft 
and are part of what is bundled together and called “Microsoft Office.”  Another term for 
computer programs is “software.”  Some programs may come preloaded on a PC, but you 
can also buy them separately.  

 
B.  An operating system is the software program on a computer that manages all of the other     

programs. Microsoft makes the Windows operating system used on most computers. 
Different versions of Windows include Windows 98, Windows XP, Windows Vista, and the 
latest version available in the library, Windows 10.  
 

 

II. Overview of Windows  
 

A.  Desktop: The desktop is the main screen area that you see after you turn on your computer 
and log on to Windows. Like the top of an actual desk, it serves as a surface for your work.  
The desktop has shortcuts to programs, also called icons. Icons are small pictures that 
represent files, folders, programs, and other items. Double Click on an icon to open the 
program or file it represents 

Computer Basics Working with Windows and File Management 

Icons 

Desktop 

Start button 



County of Henrico Public Libraries   

 

  
2 of 15                                                                                                                        Rev. 9/24/2019 

 

  B. The Start Button:  Located at the bottom left corner of the screen, you can find all the     
programs and functions of the computer here. 

 
1. Click on the start button at the bottom left of your screen (Or press the Windows 

logo key, which is between ctrl and alt on the keyboard.           
                  

         
 

2.  Looking on the instructor’s computer, notice the words; documents, pictures, music, 
computer, etc. You would have these choices on your personal computer. Clicking on 
the word takes you to that area.  

 
C.  The Taskbar: The area at the bottom of the screen and to the right of the Start button is the 

taskbar where you see icons for some programs. Your personal computer can be 
customized by adding the programs you use most often to the task bar.  

 
1. You can use the taskbar to search for a program or file or as a short cut to open the 
programs on the taskbar by clicking once on the icon. 
 
2.  The bar also shows icons for programs currently open, so you can switch between 
programs by clicking on the appropriate icon. More on this later.  Hover the mouse 
pointer over the icons to see a preview or thumbnail of the program. 

 

3. The right end of the taskbar is called the Notification area.  This area displays the 
current date and time as well as other useful icons. Click on the date to see a monthly 
calendar. 
 

        
 

III. About File Management 

A. Why learn file management?   
As you use your computer, you will produce and acquire documents, pictures and other 
files that you wish to save and use later.  In order to find those files again you need a 
system to manage them.   

 
B. How are files organized? 

Paper files, which often include letters, financial statements and other records you want to 
save, are usually stored in folders in a filing cabinet.  If there are a lot of items to be filed, 
the cabinet will have multiple drawers with several folders in each drawer.  This structure is 
similar on computers except the files are stored electronically instead of in cabinets. 

 
C. What are files and where are they stored? 

A file is anything you produce or acquire while using your computer.  It can be a letter, a 
picture, a song, or any other kind of document.      
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Saved files can be organized into folders.  This is the folder icon, which we will be seeing 
quite a bit as we go through this class. 

 

IV. Opening a program and getting familiar with Microsoft Word 

A. Creating a File: We will now use Microsoft Word to create a file, save that file, close the 
file, and open it back up.  The term “file” is another name for a document saved on the 
computer. 

 

1. Double-click on the Word icon on the desktop. In our version this will open a menu 
of Microsoft Word templates. In some older versions, this opens directly on a blank 
page.  Choose the first one, Blank Document, by clicking on it.   

2. We will create a very simple document:  

 Type your name, press the Enter key on the keyboard  

 Type the date.  
3. Let’s learn about other parts of the screen.  

B. The Ribbon  

The ribbon provides easy access to commands.  In order to make finding the right 
command easy, commands on the ribbon are broken down into categories, each located 
under the appropriate tab. 

 
  

 
 

C. The File tab, located in the upper left-hand corner of the program window, contains basic 
file management commands, including New, Open, Print, Save, and Close. The back arrow 
takes you back to your document.  

 
D. The Quick Access Toolbar 
The quick access toolbar is located above the Ribbon. It is customizable and includes those 
commands that are most frequently used and require only a click of the mouse to execute.  
 
       1. The right corner of this bar includes several important commands. 

 Minimize. This reduces the current window so you can work on other windows 
behind it without closing the window. You can retrieve it from the task bar. 

 Restore up or down. Makes the current window take up the full desk top area 
(restore up) or take up a smaller portion of the viewing area (restore down) if you 
need to have two windows in view at one time. 

 Close. This closes the program currently showing, and turns red when active. 
 

 

Tabs 

Quick 

access 

toolbar 
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  2. Undo/Redo Feature 
 

 Another important feature at the upper left hand corner of the program window is 
the Undo/Redo feature. This feature allows you to undo the last action you 
performed and looks like an arrow curving to the left. When the button is gray 
there is nothing to undo. When the button is bright it is enabled, and you can 
undo (or redo) actions one at a time until you are back where you started. 

 

 If you later decide you didn’t want to undo an action, you can click Redo on the 
Standard toolbar.  Redo appears only after you have used Undo, and looks like 
an arrow curving to the right. 
Click Undo on the Standard toolbar.  This should take away the date. 
Click Redo on the Standard toolbar.  The date should reappear. 

                
E. Saving a File 

1. Click on the Save button   on the Quick Access Toolbar. This will open up a 
screen in which you tell the computer where you would like to save your document, and 
allows you to name the file. For the purposes of this class, we will save our documents 
to the Desktop.  

 
Note: You also want to click the Save button frequently as you work, to make sure 
your work is preserved. 

 
2. Notice that the title bar says “save as”.  When you save a file for the first time it 
automatically comes up as save as. You could also go to the file tab and select Save 
As. In addition, Save As is used when you start with an existing file, make changes to it, 
but want to keep the original document intact while also having the new one. This is 
done by changing the name of the file after selecting the Save As command. 
 
NOTE: If you were doing a monthly newsletter you would want to add new information 
each month while still keeping the same format.   Here is how to do it: 
Write the first newsletter 
Save it using the “save as” command above 
When ready to write the second newsletter open the one previously saved 
Using “save as”, rename it with the current month and type your new information; use 
the “save” command as you make changes and before you close the file 
 
 If you did this every month for a year, you would have twelve files.  If you simply used 
Save you would only have one file and no longer have the information from the prior 
months.   
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3. Word will default to selecting “This PC” in the column to the left. 
 
4. Click on the word “Browse” or select the appropriate drive. 
 
5. Select the Desktop from the list. By choosing the Desktop as your location for your 
file, you will know to go back to the Desktop to locate your file when you are ready to 
reopen it. A path is created to find your way back to the file, depending on where you 
want to keep it.  One crucial part of using a computer is keeping track of the files you 
create so you can find them later.   

 
6. Click in the File Name box and type your initials and the first three letters of the 
current month.   
 
7. Click on the Save button at the bottom right or hit Enter on your keyboard. 
 
                                                                             

F.  Title Bar 
The title bar displays the name of the file or document that you are currently using.  It also 
displays the name of the program in use. Look up on the quick access toolbar on the very top 
of your screen. It will now show the name of the document you just saved. 

  
 G.   Closing a File 

1. Click on the File Tab at the top left hand side of the screen. 
 
   2.  Select Close from the list on the left.  
 
 OR If you are closing the document and leaving Word (or whatever other Microsoft program 

you might be using) click on the Save icon on the Quick Access Toolbar to save the 
work done on the open file. On the other side of the Toolbar, click on the X to close the 
program. If you have not saved your work, Microsoft will give you another chance by 
asking if you want to Save, Do Not Save, or Cancel (go back to working on the current 
file). 

 
 

This PC 

Browse  
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V.  Windows: What’s the buzz about? 

A.  Operating System 

An operating system is the software program on a computer that manages all of the other 
programs. Microsoft makes the Windows operating system used on most computers. 
Different versions of Windows include Windows 98, Windows XP, Windows Vista, and the 
latest version available in the library, Windows 10.  
 
The operating system is called Windows because Windows are what they call the screens 
we have been using to do different tasks. Think about it. When you opened up Microsoft 
Word a new screen or window opened with the program.  

 

 Our next task will be working with two windows, one in Word and another in Chrome.  

 We will copy a picture from Chrome (a window) to your file in Word (a second window).  

B. Opening a File 

1.  In Word, click on the File Tab and select Open. 

 
2. You will see many options for locating saved files. Word defaults to Recent 

Documents where you will see a list of the most recently created or modified files. 
This helps locate files that may be stored in different places. However, we are looking 
for the Desktop, which is where our files are saved for this class. The best way to do 
this is to double click on This PC in the list of locations. This takes you to File 
Explorer. 

 
OR 

   Go directly to File Explorer. Look on the Taskbar and click on the icon that looks like file 
folders in a tray.    

 

 
 
 

This will open File Explorer, the program you use to explore your computer and work with 
files and folders outside the programs you use to create files.  In other words, File Explorer 
is the tool you use to manage the files you create; this is why its icon looks like a physical 
tray with folders stacked in it. 
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  Parts of the screen: 
 

a. The address bar is at the top.  It tells you where you are in the computer.  As you 
move around in File Explorer and navigate to other areas of your computer system, 
the address bar will change.  This is an important piece of information we will use 
when we save files. 

 
b. The quick access toolbar is above the address bar.  The buttons change depending 

on where you are in the folders and what you select. 
 

c. The navigation pane runs down the left edge of the screen and has several sections. 
Depending on how much is on your personal computer, you may need to maximize 
the window or use the scroll bar within the navigation pane to see all of the sections. 

 d. Scroll bars: Appear on the right hand side of the area and occasionally at the bottom 
for more horizontal content. When there is more information in a section than can fit in 
the space you can use the bar to access other parts of the screen or “scroll” through the 
page. This will allow you to see all the information on the page. Scrolling can be done 
up and down or side to side. 

There are 3 basic ways to scroll. 
 

Folders for holding your files 

  

Quick Access Toolbar 

  

Navigation 

Pane 

Address Bar 

Details Pane 

Content Area 

Scroll Bar 
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 Left click on the up   or down scroll arrow. The page will move up or 

down one line. Hold down the mouse button to scroll continuously. 

 Left click and drag the scroll box  on the slider up or down. The page will 

move up or down one screen. 

 Click an empty area of a scroll bar above or below the scroll box to scroll up 

or down one page. Use the arrows on the right hand side of your keyboard to 

move that page.  

 
NOTE: If your mouse has a scroll wheel, you can use it to scroll vertically through documents, 

lists, and web pages. To scroll down, roll the wheel backward (toward you). To scroll 
up, roll the wheel forward (away from you.) 

 
e. The content area displays icons for folders in your user account.  Windows creates 
these folders automatically to help you organize your files by type. 
 
f. The details pane stretches across the bottom of the window.  It tells you how many 
items are in the section you selected, and how you are viewing them. 

C.  Chose and click once on Desktop in the Navigation pane. Locate your file (your initials) in 
the Content area and double click on it to open. 

D. Open Chrome by double-clicking on the Chrome icon on the desktop, or if chrome is on your 
taskbar, only one click is necessary. 

 
VI. Working with Windows 
 

You may have noticed that we now have two windows open. If you open more than one program or 
document, your desktop can quickly become cluttered with windows. Keeping track of which windows 
you have open isn't always easy, because some windows might partially or completely cover others. 
You can use the taskbar to toggle or switch between windows.  

 
A.  Taskbar  

The taskbar provides a way to organize all of your windows. Each window has a 
corresponding button on the taskbar. To switch to another window, just click its taskbar 
button. The window appears in front of all other windows, becoming the active 
window—the one you're currently working in.  
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 If Chrome is not your active window, click on the taskbar button for Chrome.  

 If you have more than one window open in the same program, a small pop up icon 
lets you choose which one to activate. For example, if you were working on two word 
documents at the same time, when you hover over the word button on the taskbar, 
you will see small images of both documents and can choose one or the other. 

 You can also close a window from the task bar by clicking on the X in the corner of 
the small image. 

 
B. Browser 
 
The World Wide Web provides quick access to information and entertainment worldwide.  You 
explore the web using a Web browser, which is a software program designed to make 
browsing the web easy.  Examples of web browsers are Internet Edge, Firefox and Google 
Chrome. To learn more about browsing the web, take an introductory Internet class. Close 
Chrome by clicking the X in the top right corner of the window. 

 
                                                                          

VII. Creating Folders and Saving Files 
 
Folders, which are used to organize your files, are created using the File Explorer section of 
the computer.  Files from many different software programs can be saved in the same folder.  
Most of the time, you create folders using File Explorer, no matter what software program you 
use to create the file. 
 

         A. Create a folder 
 
1. To create a new folder start by going to the folder or library in File Explorer where you 

want your new folder to be.  For this class we are going to create a new folder on the 
desktop.  
 

2. Select File Explorer on the Task Bar.  
 

3. Click on the desktop. Notice how the Command options change. 
 

Taskbar 

Taskbar button for Word Taskbar button for Chrome 
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4. Select New Folder from the Quick Access toolbar.   
 

5. You will notice that the words (New Folder) are highlighted in Blue. It is at this time that 
you can name your folder.  Don’t move the cursor or mouse before you start typing. 
 

6. Type “Personal” over the words (New Folder) to name your folder.  Hit the Enter key on 
your keyboard. 
 

B.  Create a second folder 
 

1. Double Click on the icon for your Personal folder to open it. 

2. Right click in the empty white space to open a menu; select new and folder. 

3. Type “Contacts” over the words (New Folder) to name your folder.  

4. Hit the enter key on your keyboard 

  
   D.  Using what we just went over 
         We are now going to save a file to the Contacts folder that you created in your Personal folder.  

                                                                             
1. Return to the birthday file you created. 

2. Save the file by selecting the File tab from the Ribbon, and choosing the Save As option. 
 

3. A window will open that gives you several options where to save your file.  Click on Browse 
from the list of options. 

 
4. Choose Desktop in the navigation pane that opens up to the right. 

5. Find the Personal folder you just created.  

6. There are several ways to open folders; we will use two. 

7. First, select the Personal folder and double click to open it.  

8. Select the Contacts folder, look at the buttons at the bottom of the window and choose 
Open.  
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9. Click into the File name box and rename the file you just created “Dates.” Choose Save to 
save to the Contacts Folder. Notice the path created in the address bar. 

 
10. Go to the File Tab and choose close to close the Word document. 

VIII.    Viewing Files 
 

 Let’s look briefly at our files.  Open the Personal folder. Right click in the white space to the 
right of the folder names and select View from the drop down menu that appears. You can also 
access this menu from an icon at the far right of the Quick Access bar. 
 
 Two of the options are especially useful in certain situations.  For example, Extra Large Icons 
is great in a folder full of pictures.  Another example is Details, which has the advantage of being able 
to sort files by the date you last modified them.   
 
 Leave it on Details; close out of the Personal folder. 
  

IX. Moving Files  
 

We will be using files that are already saved to your Desktop to demonstrate different ways to 
move files around in Windows. 
 
A.  Drag and drop  

This basic method of moving files around is ideal when the folder where you want to 
relocate the file is near the file. 
 
1. From the Desktop, double-click on the Personal folder to open it, and then double click 

on the Contacts folder. 
 

2. Click on the Dates file and hold your left mouse button down.  Drag the file until the 
image hovers on Desktop. Let go of the mouse button and the file will go out of the 
Personal folder, and on to the desktop. 

 
We have moved the Dates file out of the Personal folder using the drag and drop method.  We 
will use another method to move the file back into the Personal Folder. 
 

B. Moving a file using File Explorer 
  
This method lets you select the file(s) you would like to move and then select where they 
should go.  Navigate to the desktop, if your computer is not already displaying the Desktop. 
 
1. Select the Address file and right click it to open what is called a context menu. 

2. Use the left mouse button to choose cut from the context menu to remove the file from 
its current location.  The icon fades although the file remains in its original location. 
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3. Select the Personal folder. 

4. Right click on the folder and choose paste. 

5. Click the red X to close. 

C.  Checking what we’ve done 
 
We will now open the Personal folder, look in the Contacts and confirm that our files are there. 

 
1. Double click on the Personal folder on the Desktop. 
2. Confirm that it contains Address.  
3. Use either of the above methods to move Dates into the Contacts folder. 

 

X. Renaming Folders 
 

As you work with Windows there will be times when you want to make changes to a folder 
name. There are two ways to rename a file or folder using Windows.   
 
A.  First way to rename: Right click   
 

1. While you are in the Personal folder, select Contacts and open it. 
2. Right click on the Dates file. 
3. Choose rename. 
4. The Dates folder current name will turn blue; you now have the ability to change the 

name. 
5. Type in “Me” and hit enter. 
6. You see the folder with the new name on it located in the Contacts file. 

 
B. Second way to rename:  Use File Explorer 
 

  1. Go to File Explorer; select desktop, open Personal, open Contacts. 
  2. Find the Me folder; click once 
  3. Find “organize” in the Home tab on the command bar; find “rename” on the menu. 
  4. From this point the process of renaming is the same; close out File Explorer. 
 
XI. Storage Options 
 For this class we have been storing our items on the desktop and/or in the computer library. Let’s 
briefly review different options for storing your files. 

A. Hard Drive  
The hard drive is the storage area inside your computer where you can save files.  It is called 
drive C. On your home computer, you will likely save most of your files to the hard drive.  These 
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are the pre-programmed folders under “This PC” in Microsoft 10, or “Libraries” on older versions 
to hold text, picture and music files. 

 

              

 
B.  Desktop                                                                                                                 

For this class, we have saved items to the Desktop.  This is an area where you can 
temporarily save files on public, shared computers such as the ones here in the library.  For 
security purposes, we do not allow use of the hard drive on the public-access library 
computers.  

C.  Portable Storage  

Storage devices on which you can save files and take them with you to open on another 
computer are called portable storage devices.  The two most widely used portable storage 
devices are flash/thumb drives and CD/DVD disks. 
 

 
1.  Drive (D :) is the CD/DVD drive. 
2.  Flash/thumb drives are portable storage with large memory capacity. They can be 
connected to your computer by the USB ports at the front of your computer and they are 
usually the (E :) or (F :) drives.  Flash/thumb drives are the most compact, reliable and 
easiest to use of the portable storage devices. 

                     
 

D.  Microsoft OneDrive 
OneDrive is online file storage offered by Microsoft. If you have a Microsoft account, files 
can be stored in the Cloud and can be accessed from multiple devices. 

 

XII. Deleting a File 
 
A.  Our work with this file is done. Learning how to delete files can clear up unneeded clutter 

on your desktop and free up extra space on your hard drive.  

Hard drive 
Thumb drive 
(removable storage) 
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To delete a file outside of the program where it was created, make sure that the file you 
want to delete is closed. You cannot delete an open file from File Explorer.  

 
 
B.  File explorer gives you access to the available drives.  You can manage your files here:  

open, rename, reorganize, or delete them, for example. Today we will use Quick Access to 
delete the file we created in class. 

 

 

C. Recycle Bin 

    When you delete a file, it is temporarily stored in the Recycle Bin, which is represented by 
 an icon on the desktop. Think of the Recycle bin as a safety folder that allows you to recover 
accidentally deleted files from the Recycle bin and restore them to your computer. 
 
 
 

1. To close our Word file click on 
the File Button and select Close. 
  

2. On your computer screen, click 
on the start button at the very 
bottom left hand corner.  
  

3. Select Documents from the box 
that pops up.   

 

1. Choose the area where your file is saved. (Desktop) 
  

2. Click on the name of your file, it will become highlighted in blue 
 
3. Click on the “Organize” tab. 

 
4. Click on the word Delete.  You will be asked, “Are you sure you want to move this file 

to the Recycle Bin?” 
   
5. Click “Yes” and your file is deleted. 

 
6. You can also access Delete by right clicking on the file for a short cut menu. 
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D. Emptying the Recycle Bin 

To permanently remove files from the computer and reclaim any hard disk space they were 
using, you need to permanently delete files from the Recycle Bin. You can choose to delete 
individual files from the Recycle Bin or empty the entire Recycle bin at once. You can either 
right click or double click on the icon; then choose “empty the recycle bin.” 

NOTE: To recover a file, double click on the Recycle Bin on the desktop. To restore a file, 
right-click it, and then click Restore. To restore all the files, click Restore All Files on 
the toolbar. 

 XV.  Windows Help System 

  

 

 

B. Microsoft Office Online 

Additional help topics can be found on the Microsoft Website. The direct web address is 
www.office.microsoft.com.   

 

Thanks for attending! 

A. Windows Help 
At any moment while in Windows you can use the Help 
System to get answers to questions. You access the 
Help feature by selecting Help from the Start Menu. 
You can pose all sorts of questions by simply typing in 
a subject term, such as printers, hardware, security, 
etc.  When you enter a term the help system responds 
with a variety topics related to the term.  

 

http://www.office.microsoft.com/

